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1 FXNEXT Desktop Trade Terminal (1.0.6729)
1.1 Product Description

The “FXNEXT Trade Terminal” is a software system that allows clients to trade Forex and Binary Options
instruments at Windows OS

1.2 Installation
121 “FXNEXT trade terminal” installation
Double click on “FXNEXT.Terminal.Setup1.0.6729.exe” to start FXNEXT terminal installation

~3 FXGO.Terminal Setup1.0.6729.exe

1.2.2 Microsoft .NET Framework installation

Depending on OS installed, “Microsoft NET Framework™ and “Microsoft Visual C++” installation could be
required

3 FXLITE far MT4 Setup (=]

Far the following components:

Microsoft . MET Framework 4.5 [x86 and x64)

Flease read the following license agreement. Press the page down key to see the rest
of the agreement.

MICR.OSOFT SOFTWARE SUPPLEMENTAL LICENSE TERMS

NET FRAMEWORK 4.5 FOR MICROSOFT WINDOWS DPERATING
SYSTEM AND ASSOCIATED LANGUAGE PACKS

Microsoft Corporation (or based on where you live, one of its
affiliates) licenses this supplement 1o vou, If you are licensed to
Lse Microsoft Windows operating system software (the

L b e i e mem Hede o e lmeman b Wi e i b mm i BF

E Wiew ELILA, for printing

Do you accept the terms of the pending License Agreement?

IF you chooze Don't Accept, install will cloze. Tao install you must accept this
agreement.

Accept Don't Accept

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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Click “Install”

2 PXCLITE for MT4 Setup (=3

The following components will be installed on your machine:

¥isual C++ 2013 Runtime Libraries [x86)

Do you wizh to install these components?

If pous chiooze Cancel, setup will exit.

Cancel

& FYLITE for MT4 Setup (==
"Io‘ Ingtalling Microzoft MET Framework 4.5 (86 and =&4)...
-
[
Cancel
Installing “Microsoft Visual C++”

S FX LITE far hT4 Setup 3

"lo‘ Inztalling Visual C++ 2013 Runtime Libraries [<86)...

-

| Cancel |

15 Micrasoft Visusl C++ 2013 Redistributable (<86) - 12.0.20501 Setup |- | & |25

Microsoft Visual C++ 2013
Redistributable (x86) - 12.0.30501

MICROSOFT SOFTWARE LICENSE TERMS

MICROSOFT YISUAL C+ + REDISTRIBUTABLE FOR ¥ISUAL STUDIO
2013

These license terms are an agreement between Microsoft Corporation (or
hazed anowhere won live nne Af ite affiliates’ and won Pleass read tham

—

gree to the license terms and conditions

P—
Insta | Close |
I 0

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606

Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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FXNEXT trade terminal

setup Choose installation

path

15 FXGO Trade Terminal

Select Installation Folder

%

The inztaller will install F<G0 Trade Terminal to the following falder.

Ta inztall in this folder, click "Mest™. Toinstall to a different folder, enter it below or click "Browse".

Eolder:
C:AProgram Files [36)5F<G0 Trade Terminals

Browze. ..

Install FXGO Trade Teminal for yoursef, or for amyone who uses this computer:

Installation complete

() Everyane
(®) Just me
Cahcel | | < Back | E Mest > ;
- —
157 FXGO Trade Terminal - X

Installation Complete

FG0 Trade Termminal has been successfully installed.

Click "Close" to exit.

Flease use ‘Windows Update to check for any critical updates to the MET Framework.

Cancel < Back Cloze

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606

Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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1.3 Running
1.3.1 Launch FXlite client terminal

Click on shortcut FXlite For MT4 to start client terminal with FX lite plugin.

2]
FXG0 Trade
Terminal

Now you can login with existing account provided by your broker company, or register new demo account if broker

allow to do this via terminal

File View Tools Help
P e o [ C¥ CT| M1 MS M15 M30 H1 H4 D1 W1 MN

|Symbols v X EURUSD, M15 > | USDCAD, M15 -
Symbol Bid Ask |
— Create demo account
MName:
Password:
Symbels | Binary Options E-mail:
Tick Chart ’ Server: FXGO-Trading I ¥
':' """""""""""" | Create || Cancel v 1 X
Seorpees r|0.L0000 {1 |d Opentime Type Size Symbol Open price S/L T/P Price  Swap
0.00000
Trade Robots | Favorites | Tick Chart Trade | BO Positions | Trade History | MNews

Disconnected

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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Logging in with existing trader account

Choose “Login” point in “File” menu to login trading server using existing trading account credentials.

= FXGO Trade Terminal

ew Chart

Tools  Help

Create demo account..

Exit
NZDUSD
AUDCAD
EURGBP
GBRCHF
USDCHF

CUEInY

1l

Torss1

097287
n80c7E

1120

Supply your existing account login credentials and click “Login.”

Fila View Tools Help

|Symbols

| Symbol Bid
Symbeols | Binary Options

Tick Chart

N
-0 X

Ask |

B

M1 M5 M15 M30 H1 H4 D1 W1 MN

EURUSD, M15 x| USDCAD, M15

Login:

Passwo

- Server:

4l

: 1005 i
sassss

FXGO-Trading -

Save account information

Trade Robots | Favorites

Disconnected

| Login | | Cancel
- X
r{0.00000 || |d b Open time Type Size  Symbol Open price S/L T/P Price  Swap
E 0.00000
é----é 0.00000
Tick Chart Trade | BO Pc'_s:t ons . Trade H __ News
0/0

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606

Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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Choose “Create demo account” point in “File” menu to register new demo account.

Choose demo server provided your broker company, type password and click “Create”

< Create demo account

*

Mame: your name

Password: esessssss

your@email.com

E-mail:
"' Server; FXGO-Trading v

I Create I Cancel

Demo account created, remember account number and password for further login.

— FXGO Trade Terminal

File View Tools Help

& M1 M5 M15 M30 H1 H4 D1 W1 M

Symbols ¥ 1'% / EURUSD, M15 X | USC
Symbol Bid Ask

EURCHF 1.16396 1.16401

NZDUSD 0.678%6 067905

AUDCAD 097416 097433

EURGEP 0.89536 0.80542

GBPCHF 1.29990 1.20001

USDCHF 0.09453 099468

CHFIRY 112473 112.516

NZDIPY 75.060 75.974

GBPCAD 1.71970 171998
Symbels | Binary Options
Tick Chart v ax

Id Open tir|

057382
Trade Robots | Favorites | Tick Chart | Trade | BO Positions | Trade
Connected |Acc::|unt: 1009 i»alance: 10000.00 USD  Equity: |

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606

Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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Trading regular forex symbols
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Double click on any “Instrument” in “Symbols” window to open order

A FXGO Trade Terminal

File  Vies Tools

Help

Symbol Bid
NZDUSD
USDCAD
EURAUD
GBPCHF
EURUSD
CADCHF
GEPUSD
EURIPY 3 8
USDCHF 099696
EURCHF 116321
GBPIPY 146,389

13
158186
130046

AUDCHF
GBPAUD

176853

Symbols | Eflkary

4 Indicators
Accelerator
Alligator
EMA
MACD
RSI
SMA
Standard Deviation
Stochastic
ZigZag

Trade Robots | Favorites

Connected

Account : 1005

Ask  High

132330 1.
1.58343
130226
1.16741
0.75456
1.20509

1.58208
1.30062

0.75382
1.30450

1.76883

Tick Chart

Balance : 9796.

v QX EURUSDbo, M1 >

132303
1.57872 12
1.29885
116412 1
0.75306
130058 1

- qx

BO Positions

d Open time Type  Investment
1086 2018.07.20 11:20:06 DOWN 5.00
1085 201807.20 112000 up 5.00
1084 2018.07.20 11:19:53 DOWN 5.00
Trade | BO Positions | Trade H News

27 USD  Equity: 9796.27 USD

Margin : 10.00

Free margin : 9786.27

Symbol  Open price Price Expiry
EURUSDbo 116530 116675 2018.07.21 11:19:06
EURUSDbo 116520 1.16675 2018.07.20 12:20:00
EURUSDbo 116532 116618 2018.07.20 11:49:53

Margin level : 9796

July 20, 11:48 - July 20, 12:16

_— T 'mm,

4 x
Payout Status
0.00 LIVE
0.00 LIVE
0.50 LOSS
2.90mb / 39%kb

1.16739
116727
1.16716
1.16705
1.16693

1.16682

1.16659
1.16648
1.16637
1.16625
1.16614
1.16603
1.16591

Choose order parameters and click “Buy” or “Sell” to open position

File View Tools Help

=l e

Symbols
Symbol Bid
067640

NZDUSD
USDCAD
EURAUD
GBPCHF
EURUSD
CADCHF
GBPUSD
EURIRY
USDCHF
EURCHF
GBPIPY
EURCAD
AUDCHF
GBPAUD
GBPCAD

1.16706

( 6
1.30465

Symbols | Binary Opt
Trade Robots
4 Indicators
Accelerator
Alligator
EMA
MACD
RSl
SMA
Standard Deviation
Stochastic
ZigZag

.

Ask
067649

1.582
1.30060
116710

130226
116741

130509

S M1 M5 M15 M30 H1 H4 D1 W1 MN

X

EURUSD, M1 X

Llow  Time
067489 121

12;

open:
12

=

2

1.29885
116412 12

130058 1

146.118

154190 1

- 11323850
- 1132340

132330

- 1132300
- 1132200

- 1132280

Symbol:
Volume:
Stop loss:
Take profit:

Type:

USDCAD
o1

oooooo 2 [ 132315
oooooo 2 [ 132315

Market execution

Prices must differ from market price by at least 5 pips

1.32311

1.32319

Sell | Buy

1.16682
1.16659
1.16637
116614
116591

1.16569

1.16546 l
116523

1d Open time

Investment  Symbel  Open price Price

1086 2018.07.20 11:20:06 DOWN 500 EURUSDbo 1.16530 1.16708 2018.07.21 11
1085 up 500 EURUSDbo 116530 1.16708 2018.07.20 1
1084 2018.07.20 11:19:53 DOWN 500 EURUSDbo 1.16532 1.16618 2018.07.20 11

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606

Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com

Expiry

:19:06
00
49:53

Payout Status
0.00 LIVE
0.00 LIVE
050 LOSS

116501
116478
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Position opened

.o < Order

A Symbol:  EURUSD
SR S N S DU SN SO S P

R B Volume:| 1%
SRR S S R S s =

' : : ' : : : Stop loss: 116692 1.16710

Eprofit:| 1167565 | 116710 |

FXG0 Trade Terminal

@ Pasition #1087 Buy 1.00 EURUSD at 1.16712 opened. I
1.16708 1.16712

Type: Market execution

Prices must differ from market price by at least 2 pips

e | sel || Buy
Opened positions appears in “Trade” tab list
Trade v 1 X
i SR EENTS == i Symbol OCpen price S/L /P Price  Swap Profit Comment
‘ 1036 2018.06.21 14:03:11 Sell 00§ NZDUSD 068741 000000 000000 069041 000 -2.89
. nprom e B CU| NZDUSD 068738 000000 0.00000 069032 000 293

Trade | BO Positions | Trade History | News |

Double click on any opened position to modify or close it.

Position #1036 Sell 0.01 NZDUSD

Symbol: NZDUSD

Stoploss:| 06908413 | 069039 |

Take profit:| 069010 | 069039 |

0.68051

R
T T
Biieh bt it S bl Eehl
EE R L EEE T

'

'

'

'
cooopooontdo

'

'

'

'
cooopoooo

Prices must differ from market price by at least 10 pips

0.69035 0.69043

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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Position closed
& Position #1115 Sell 0.50 EURUSD x
A E i Symbol: EURUSD
sessfessshiessstesssbosaslccoctyl : ————m
8 8 1 FXGO Trade Terminal =

| @ Position #1115 Sell 0.50 EURUSD at 1.17254 closed with profit 126,50 I

o 1001

least 2 pips

b Theoa0

| Modify position | | Close position |

To open pending position, choose “Type” = “Pending order”, enter “Open”, “Stop loss” and “Take profit” price

then click “Sell limit” or “Buy stop” button.

Symbol: | USDCAD

Stop loss: 132714 132750

132810

132807

1.32796

Takeprofit | 132807[% | 132750

132785
Type: | Pending order

132774
Openprice:| 132787} Expiry: |

132763

Prices must differ from market price by at least 5 pips

132746 132755

Sell Limit | Buy Stop

Symbol: USDCAD

(O Trade Terminal

created. 1

@ Pending order #1042 Buy Stop 0.05 USDCAD at 1,32787 r

- -

te by at least 5 pips

132743 1.32751

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606 10
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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You can see list of opened positions at the bottom of terminal in “Trade” tab.

-

Id Open time Type Size  Symbol Open price 5/l /P Price  Commission  Swap Profit Comment

2018.07.2012:21:000_Buy| 1.00] EURUsD] _1.16720] 0.00000] 0.00000f 1.16706] o000 _000] 1300l |

| BO Positions | Trade History | News |
—

To close opened position, double-click on it in “Trade” tab and then click “Close” in order window.

URUSD

Symbol: EURUSD

Stoploss: | 0o0000[%] [ 116740 |

1116740

- 1116726

Takeprofic| 000000 %] [ 116740 |

1116715
| Prices must differ from market price by at least 2 pips

11.16704

T 116737 1.16742
BT

1116671

Position closed

£ Position #1083 Buy 1.00 EURUSD x

Symbol: EURUSD

Position #1088 Buy 1.00 EURUSD at 1.16720 closed with profit :I

-26.00
yy at least 2 pips

[ o |
rr-Tooys—1.16698

116622

1.16671

| Modify position | | Close position |

You can see list of closed positions in “Account History” tab at the bottom of terminal

TradeTools Technology, Inc.

100 S. Wacker Drive, Suite 225, Chicago, IL 60606 11

Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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-

Time Type Message

2018.07.20 12:20:00  Binary Option Position #1085 WIN at 1.16688 payout: 9.00 ”
2018.07.20 12119:16  Close order Position closed: position #1087, Buy 1.00 EURUSD, open price: 1.16712, close price: 1.16692, sl: 1.16692, tp: 1.16'.-
2018.07.20 12:19:10 | Open order Position #1087 opened, Buy 1.00 EURUSD, open price: 116712, sl: 1.16692, tp: 1.16756

2018.07.20 11:49:53  Binary Option Position #1084 LOSS at 1.16618 payout: 0.50
2018.07.20 11:29:46  Binary Option Position #1083 WIN at 1.16554 payout: 8.50
2018.07.20 11:24:37__ Binary Option Position #1082 LOSS at 1.16589 payout: 0.60 v

Trade | BO Positio| Trade History |
| S

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606 12
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com



—*—

TradeToolsFx
14.2 Trading Binary options symbols

In “Market Watch” window there are symbols with bo postfix (if these symbols are not present try to Show All
symbols from Market Watch context menu).

A FXGO Trade Terminal

File View Tools Help
i - M1 M5

15 M30 H1 H4 D1 W1 MN

EURUSD, M1 X

Binary Opticns
Symbol Bid
ETHUSDbe
LTCETCho
BCHUSDbo
LTCUSDbo 84.636
BCHETCbo 0.10666
ETHETCbo 0.06202
ETCUSDbo 7465.00
NZDUSCbo 0.67642 067644
T ogoeas| [T 099656
GBPUSDbo 1.30502 1.30509
USDCADbo 1.32307
AUDUSDbo
USDIPYba
EURUSDbo

S}fr‘"lboll Binary Options I
Trade ROUE— - QX

4 |ndicators
Accelerator

o

To start trading binary options click on any symbol with bo postfix. “Binary Option Trading” window will appear.

File View Tools Help
: = M1 M5 M15 M30 H1 H4 D1 W1 MN

Binary Options EURUSD, M1 < |

Symbol
ETHUSDbo
LTCETCha
BECHUSDbo
LTCUSDbo
BCHETCbo
ETHETCbo
ETCUSDbo
NZDUSDbo
USDCHFbo
GBPUSDbo 130578
USDCADba 131663
AUDUSDbo 0.73840 073847
USDIPYbo 112,132 112.139
EURUSDbo 1.16795 1.16795

Trade Robots > X Payo ut 8 5 %
4 Indicators

Accelerstor Trade Return 9.25
Alligator
EMA
MACD
RSI
SMA 09:04 0819 09:34 0%:49 10:04 10:38
Standard Deviation
Stochastic
ZigZag

open:

A Binary Option X

006210 EURUSDbo

745570

099629

‘Trade History

Choose “Binary Option” order parameters and click “Up” or “Down” buttons to open Binary option position.

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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Investment volume
Click on “Investment” combo box to choose BO order volume.

~# Binary Option

NZDUSDbo Investment: Expiry: | 60 sec S

B S e S S i S et et ettt LT

R R b S S R R e R e e e A T
N 0010

-+--|0.67620

Payout 60 %

Trade Return 8.00

Expiration time

Click on “Expiry” combo box to choose BO order expiration time.

NZDUSDbo Investment: | 3 N Expiry: | 60 sec ©

Payout 60 %

Trade Return 8.00

Specify order parameters and click “Up” or “Down” to place your investment.

A new position will be opened. Click on open position to check the expiration status of the position.

~# Binary Opticn

EURUSDbo
1.16526
1.16506
Position: 1043 Investment: 5.00 Price: 1.16432
Type: up Expiry: 2018.06.22 11:55:51 Profit -5.00

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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Opened BO positions also displayed at the “BO Positions” tab of FXNEXT terminal.

-

Id Open time Type  Investment Symbol  Open price Price Expiry Payout Status
10417 2018.06.22 11:25:11 DOWN 5.00 AUDUSDbo 074234 0.74234 2018.06.22 11:26:11 5.00 DRAW
1040 2018.06.22 11:25:04 up 5.00 EURUSDbo 1.16393 1.16382 2018.06.22 11:26:04 0.00 LOSS

Trade | BO Positions | Trade History | News |

Once position is expired, position will be closed and client balance will be credited or debited according to the
outcome of the bet.

Binary Option
EURUSDbo
Position: 1043 Investment: 5.00 Price: 1.16522
Type: up Expiry: 2018.06.22 11:55:51 Profit 3.00
=

Closed BO position will appear at “History” tab, and “Account history” tab of FXNEXT terminal

Trade History

Time ™ Type Message

2018.08.28 15:33:59  Binary Opticn Position #1120 WIN at 1.17102 payout: 8.00

2018.08.28 15:32:59  Binary Opticn Position #1120 opened: 5.00 on DOWN EURUSDbo at 1.17113

Trade | BO Positions | Trade History | News |

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606 15
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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15 FX GO Trading terminal interface appearance

You can change charts appearance properties like timeframe, colors, time scale, chart style (bars or candles) and
chart layouts via right click menu or “interface” buttons

= FXGO Trade Terminal - O X
Fila View Tools Help
i = i H G| T M1 M5 M15 M30 H1 H4 DT W1 MN _ i

Symbols v X EURUSD,
Symbol Bid Ask High
EURCHF | 1.13940 1.15951| 1.15947
NZDUSD | 067685 0.67693 | 0.67581
AUDCAD | 096378 | 0.96306 9
EURGBP | 0.53806
GBPCHF  1.30545
USDCHF
CHFIPY
MNZDIPY

el =20 - ' -
Close Al But This Jul 25, 09:30 - Jul 27, 11:15

Float

Dock as Tabbed Document 0.880916

MNew Horizontal Tab Group
MNew Vertical Tab Group

0.88859

Symbols | Binary Options
2345  Jul26 0915 1400 1845 : Jul 27 09:00
Tick Chart

14:00 18:45 2330 Jul 26

Trade v 1 X

"‘"\.;.""':_""':" Id Opentime Type Size  Symbol Open price S/L T/P Price  Swap
1109 2018.07.27 11:01:31 Buy 0071 USDCHF 099737 0.00000 000000 099606 0.00
1108 2018.07.27 10:39:50  Sell 001 AUDCAD 096366 0.00000 000000 096396 0.00
1107 2018.07.27 10:59:45  Buy 001 GBPCHF 130618 000000 000000 1.30545 0.00

Trade Robots | Favorites | Tick Chart Trade | BO Positions | Trade History | News
Connected Account: 1009  Balance: 9952.00 USD  Equity: 9949.72 USD Margin: 86.75 Free margin: 9862.97 Margin level : 11469.42% 557
< FXG0 Trade Terminal — O *

File View Tools Help
i B ol ST T M1 MS M15 M30 HT H4 D1 W1 MN _ |-

1l

Symbols LR USDCHF, M15 X | AUDCAD. M15 s NZDUSD, M15 X

Symbol Bid Asl High £PREM, o) L ogh 2, 09:30 - Jul 27, 1115 Hul 25, 09:30 - Jul 27, 11:15
EURCHF | 115929 1.15040 1.15987 - || JEanliaicnties el sttt . - ;- |
NZDUSD | 0.67677 0.67684 0.67881 068350
AUDCAD | 0.96357| 096373 0.96550 068260
EURGBP | 0.88706 0.88803 0.88949

068130

GBPCHF | 130547 130363
USDCHF 0 0.68000
CHEIPY 111

1
NZDJPY | 75238 75,

Symbols | Binary Options

Tick Chart

22:00 Jul 26 23:00 22:00

Trade v Xx
I =

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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1.6 File menu

<= F{GO Trade Terminal

File | View Tools Help

ew Chart 1
Create demo account... i
Login.. th
Exit &7

| NZDUSD [ U007 [ 007065 | Bo7as ]

1.6.1 New Chart

New Chart — adding another chart tab to existing tabs.

— FXGO Trade Terminal

View Tools Help

New Chart 1 M5 M1

(w]
=1
T
T
:
1
1

i

Create demo account.. EURUSD, M15 USDCAD, M15 EURGBF, M15 X

Login.. ih
Exit B
NZDUSL [ U070 | WoiorE | unisal
AUDCAD 096385 0.96406 0.96559
EURGBP | 0.88758 0.88786 0.88949
[EET | [1.30614] (130630 [1.30644]
USDCHF | I
CHRIPY 111437 111499 111.804
NZDJPY | 75228 75242 75457

Symbols | Binary Options

1400 1845 23:30  Jul26  09:00 1345 18
Tick Chart =

A3 2330 Jul26 0800

Trade

You can change chart appearance (make it float or tabbed) by right click menu.

1 M5 M15 M30 H1 H4 D1 W1 MN

X EURUSD, M15 X | USDCA™ """

_h Close
. open: Close All But This
;:1 Float
#1116: Buy Sto
FIITEER Dock as Tabbed Document
R = = = = =C=T= e
10 MNew Horizontal Tab Group
{0 MNew Vertical Tab Group
12
57
8
17
g

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com

TradeTools FX FXNEXT platform - Desktop Trade Terminal - manual V. 1.0.6729 - File menu
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File View Tools Help
P G | CF T M1 M5 M15 M30 H1 H4 D1

—*—

TradeToolsFx

W1 MN

Binary Options

- QX

EURUSD, M1 X ¥ / NZDUSDbo, M15 X ¥ / EURUSDbo, M15 X ¥

Symbal
GBPUSDba
NZDUSCbo
USDCADbo
EURUSDba
USDCHFba
AULUSDbo
USDIPYbo

opune 22, 08: June 22, 11:51 opedun 20, 09:45 - Jun 22, 11:45 opeudun 20, 09:45 - Jun 22, 11

ymbols | Binary Options

Tick Chart

-1 X

116516

116500

b
Opentime  Type Size  Symbal Open price S/L e Price  Swap Profit Comment
2018.06.21 14:02:11 Sell 001 NZDUSD 0.68741 0.00000 0.00000 0.69040 0.00 -2.99
2018.06.21 13:31:27 Buy 001 NZDUSD 0.68738 0.00000 0.00000 0.69032 000 2,84
Trade Robots | Favorites | Tick Chart | Trade | BO Positions | Trade History | News
Connected ‘Acmunl: 1005  Balance: 9939.70 USD  Equity: 9939.65 USD Margin: 20,00 Free margin: 9919.65 Margin level : 40698.25% 444mb / T6kb

16.2 Create Demo Account

Create demo account, allows to register new demo account.

File Wiew Tools Help

Symbols

EURUSD, M15  USDCAD, M15 EURGBP, M15

Symbol
EURCHF
NZDUSD
AUDCAD
EURGBP
GBPCHF
USDCHF
CHFJPY
NZCJPY

open:

<= Create demo account x

Name:

Password:

Tick Chart

Symbols | Binary Options E-mail:
’ Server | FHGOTrading -

Phone: +1.312.772

;130808 [[1d Open time _Type _ Size  Symbol Open price S/

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
.2081) Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com

TradeTools FX FXNEXT platform - Desktop Trade Terminal - manual V. 1.0.6729 - File menu
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“Login”, allows to login with existing trader account credentials.

Teols  Help
u M1 M5 MI15 M30 H1 H4 D1 W1 MN _ e
v ax EURUSD, M15 USDCAD, M15 EURGEF, M15 >
Bid Ask High
115939 1.158438 1.15987
67675 | 0.67683 | D221
96384 096403 0] — Legin X
EURGBP | 0.88745 0.88752 0
1.30632 | 1.30648 | 1
0.99719| 099728 0
111,466 111.508 1 Login: your name -
75238 75.251
Password: esssssss
Symbols I—IBinar:,f Options Server: FXGC-Trading -
"' [] Save account information
: : : Hl
Tk A
____,_____,____:,_[lp‘__{___ : | Login | | Cancel

Close FXNEXT

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com

'
' .—rH!EEE |' =
T _l)q30A04 Iu _ Claaa it T e [ B [ N c

TradeTools FX FXNEXT platform - Desktop Trade Terminal - manual V. 1.0.6729 - File menu
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1.7 View

“View” menu — allows to change appearance of FXNEXT terminal

1.71 Language

Language menu allows to change interface language.

<~ FXGO Trade Terminal
File Tools  Help
: Language b (M1 M5 MI15 |
gBina|| Layout 4 Default
Sym| o [ Symbols Ask
Ell« | Binary Options 270
NIF | 949
+' | Trade Robots
U] Fovortes o
Gl | Favorites =67
U!i Tick Chart 387
Al LY Trade 127
Uil + | | BO Positions 868
|+ | Trade History 085
[ MNews _—
S}"I"'qus Oy oS
Tick Chart > O X

= FXGO Trade Terminal

File | View | Tocls Help

Language > English

H4 D1 W1 MN _ §_

Syml Layout 8 e M15 x| USDCAD, M15
Sym| o | Symbols
ELl & | Binary Options
Nl v Trade Robots
A
= i Favorites
Gl i Tick Chart
ufl # | Trade
Cl| | BO Positions
Nil & | Trade History
| News
S}"I"I'qum Ty g
Jul 26 08:45
Tick Chart
J’-EDI_""."".'"":'"".'"" _
‘ r E?‘ ' ' ! ! 18:30 2315 Jul 26

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com

TradeTools FX FXNEXT platform - Desktop Trade Terminal - manual V. 1.0.6729 - View
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1.7.2 Layout
Layout menu allows to change FXNEXT trading terminal appearance by switching on/off various
frames.
2 FAGO Trade Terminal = O x
File Tools Help
{ Language » M1 M5 M15 M30 H1 H4 D1 W1 MN _ § _
Syml| Layout L Default v QX EURUSDbo, M1 > =
Sym[« ]| Symbols Ask  High  Llow  Time en: igh: ; dJuly 27, 09:45 - July 27, 11:04
B[V | Binary Options 5956 115987 1.15684 11:04:54
NI | 7682 | 067881 0 11:04:56
& | Trade Robots
Al oy RN ----
Bf— 949 028743 11:04:5
G|l | Tick Chart 0628 130638 130205 11:04:56
Ui ¥ | Trade 19729 099734 059312 11:04:56
Cl| & | BO Positions 1.500 111.894 | 111.427 11:04:56 g
NIl & | Trade History 11:04:56 / 44.50000
ST News 96 11:04:56
Symoots Tomarywpuons
Trade Robots X
4 |ndicators
Accelerator
Alligator
EMA
MACD Trade v X
RSl Id Opentime Type Size Symbol Open price S/L
SMA L 1109 2018.07.27 11:01:31 Buy 0.01 USDCHF 099737 0.00000
Standard Deviation -
Stochastic 1108 201807271059:50 Sl 0.01 AUDCAD 006366 000000
ZigZag 1107 2018.07.27 10:59:45 Buy 0.01 GBPCHF 130618 0.00000
1108 2018.07.27 10:59:40  Sell  0.01 CHFJPY 111.450 0.000
Trade Robots | Favorites | Tick Chart Trade | BO Positions | Trade History | News
Connected Account: 1009  Balance: 9952.00 USD  Equity: 9950.85 USD Margin: 86,75 Free margin: 986410 Margin level: 11470.72% 55¢€

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com

TradeTools FX FXNEXT platform - Desktop Trade Terminal - manual V. 1.0.6729 - View
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1.7.3 Symbols
“Symbols” tab — contains list of regular Forex and CFD symbols with prices available for trading.

[ymeos T eax
Symbol Bid Ask  High Low  Time
EURCHF 115954 115965 1.15987 1.15684 11:04:07 ~
NZDUSD 067674 0.67682 0.67881 067621 11:04:07
L aupcap ] ooiial odiad ool dgasisl tod)
EURGEP 0.88777 0.88754 0.88949 0.85743 11:04:08
GEPCHF 130603 130619 1.30638 130205 11:04:08
USDCHF 0.99718 0.99728 | 0.99754 | 099312 |11:04:06
CHFIPY 111.448 111,490 111.894 | 111.427 11:04:08
NZDJPY 75.224 75238 75457 75.177 11:04:07
GBPCAD 1.71088 171115 1.71360 | 1.70996 11:04:07 ~
Symbols | Binary Options

174 Binary Options
“Binary options” tab — contains list of BO symbols with prices

Binary Cptions v X E

Symbol Bid Ask  Time
ETHETCbo = 005833 0.05836 11:03:17 ~
BTCUSDba | 7965.00 | 7965.10|11:01:02
NZDUSDbo 067677 0.67684 11:03:20
USDCHFbo | 099716 099723 11:03:21
GBPUSDbo | 130966 1.30973 11:03:24
USDCADbo 130634 | 1.30641 11:03:25
AUDUSDbe 073774 073781 11:02:20
USDIPYbo | 111,156 111.163 11:03:17
EURUSDbo | 116284 1.16284 11:03:23 ~

Symbels | Binary Options

Trade Robots * 1 X
4 |ndicators

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606 22
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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1.75 Trade Robots

Trade Robots windows allows to add technical indicators to any symbol chart. Technical indicator is a
mathematical manipulation of a security price and/or volumes aimed at forecasting of future price changes.
Decisions about how and when to open or close positions can be made on basis of signals from technical
indicators. According to their functionalities, indicators can be divided into two groups: trend indicators and
oscillators. Trend indicators help to assess the price direction and detect the turn moments synchronously or with
a delay. Oscillators allow to find the turning moments ahead or synchronously.

Symbols * QX EURUSDbo, M1 X ¥
Symbol Bid Ask high: : July 27, 09:42 - July 27, 11:01
EURCHF 1.15946
NZDUSD 0 : _
P 40.00 at 116204
AUDCAD
EURGEP
GEPCHF 1.30602 130618
USDCHF 0.99729 099738
CHFIPY 111.449 111491
NZDJPY 75.223 75.236
GBPCAD 1.71079 171107
Symbols | 8inary Options 9 09:58  10:06  10:14 : 1030 1038 1046 10:54
Trade Robots X
4 |ndicators 0742 0803 08:24— 0845
Accelerator
Alligator
EMA
MACD Trade v X
Id Open time Type Size  Symbol Open price S /P Price  Swap
SMA . 1109 2018.07.27 11:01:31 Buy 0.01 USDCHF 099737 0.00000 0.00000 099729 0.00
Standard Deviation R N _
Stochastic 1108 2018.07.27 1005950 Sell 0.01 AUDCAD 096366 0.00000 0.00000 096380 0.00
ZigZag 107 2018.07.27 10:58:45 Buy  0.01  GBPCHF 130618 000000 0.00000 130602 0.00

1106 2018.07.27 1:58:40  Sell 001 CHFIPY 111.450 0.000 0.000 11143 0.00

Trade Robots | Favorites | Tick Chart Trade | BO Positions | Trade History | News

Connected |Acc:|unt: 1009  Balance: 9952.00 USD  Equity: 9950.88 USD Margin: 8675 Free margin: 9864.13  Margin level : 11470.76% 55°%

Drag and drop indicator from “Trade Robots” menu to chart

Trade Robots > o X

4 |ndicators
Acceleratar
Alligator
EMA
MACD
RSI
SMA
Standard Deviation
Stochastic
ZigZag

Trade Robots | Favorites | Tick Chart

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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1.7.6 Favorites

Right click on specific symbol at symbols list to add this symbol to favorites list, for quick access to its trading.

Symbol Bid Ask
EURCHF 1.15944 1.15954 | ~
NZDLen pp—— e
AUD Li Mew Crder
EUR MNew Chart
GBPY Hide
USD
CHE Show All
NZD * Mawve Up
GBEt * Mowve Down -

Symba 7 Add to Favorites

Favorite High/Low %]

AUDC| Time

Sell Gnd
0.96364 | 0.963281 |
USDCHF x
Sell 00124 By
099727 | 0.99737
Trade Robots | Favorites | Tick Chart |
Connected | Account: 1009 Balance

1.7.7 Tick Chart

Tick Chart — open the tick chart of the symbol selected. The tick data comes only when the account is connected.
Thus, if an account was not active for a certain period of time, the tick chart may appear empty in the beginning.

-
'
'
'
'
.
'
'
'
'
-
'
'
'
[
'
'
.
-
'
'
'
'
.
'
V
V
|

Trade Robots | Favorites | Tick Chart |

Connected | Account: 1009  Balance

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606 24
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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1.7.8 Trade

The "Trade" tab contains information about the current status of the trading account, about open positions and
pending orders placed.

Trade * X

Id N Open time Type Size  Symbol Open price S/L TP Price  Swap
1108 2018.07.27 10:52:50  Sell, 001 AUDCAD 096366 000000 000000 096385 000 ~
1107 2018.07.27 1:59:45  Buy | 0.01 GBPCHF 130618 0.00000 000000 130602 0.00
1106 2018.07.27 10:59:40  Sell 001 CHRIFY 111.450 0.000 0000 111.495 Q.00
1101 v Stop | 0.01 AUDCAD 096413 096359 096471/ 096385 =
£ 3
Trade | BO Positions | Trade History | News |

e: 9950.00 USD Equity: 9957.90 USD Margin: 91.72 Free margin: 9866.27 Margin level : 10856.95% 552

1.7.9 Bo Positions

The "BO positions" tab contains information about the current status of the trading account, about open BO

positions.
BO Positions * 1 X
Id Open time Type  Investment Symbol  Open price Price
1105 2018.07.27 10:50:13 up 5.00 USDCHFbo 099715 099708 2018.07.27 1" ~
1104 2018.07.27 10:59:09 DOWN 5.00 AUDUSDbo 0.73780 0.73791|2018.07.27 17
1103 2018.07.27 10:59:06 up 40,00 EURUSDbo 116204 116292 2018.07.27 1
1102 2018.07.27 10:58:58 DOWN 5.00 BTCUSDbo 7965.00 7965.102018.07.27 10 ™
< >
Trade | BO Positions | Trade History | News |

: 9950.00 USD  Equity: 9958.81 USD Margin: 6503 Free margin: 9893.78 Margin level : 15314.18% 535I

1.7.10  Trade History
Trade history displaying information about all trade operations.

Trade History * 01X
Time - Type Message

2018.07.27 10:58:22  Pending order Created: order #1107, Buy Stop 0.01 AUDCAD, open price: 0.96413, sl: 0.9 ~
20180727 10:57:56  Open order Position #1100 opened, Sell 0,01 USDCHF, open price: 0.99698, sk 0, tp: 0

2018.07.27 10:57:49  Binary Opticn Position #1099 opened: 5.00 on DOWN ETHUSDbe at 464,430
2018.07.20 14:07:25  Binary Opticn Position #1090 LOSS at 1.17188 payout: 4.00

2018.07.20 13:07:25 _ Binans Ontion Position #1090 onened: 40.00 on DOWN FURLISDho at 117124 -
Trade | BO Positions | Trade History | News |

e: 9964.00 USD  Equity: 9963.90 USD Margin: 15.03 Free margin: 9943.87 Margin level : 66293.41% 532

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606 25
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com



aN

TradeToolsFx

1711  News
News Tab displaying economic news from various RSS sources.

oin
Back in early 2015 a Reddit ferum was created called r/millionairemakers which is a
5018.07.27 09:15 subreddit that tries to create a millionaire by getting one million Reddit users to donate $1
each and the forum subscribers give the money to a random perscn in hopes they can
create a millisnaire. Now the lottery-style forum is allowing [&#8230:]The post Bitcoin Cash ||

Trade | BO Positions | Trade History | Newsr‘

: 9964.00 USD  Equity: 9964.00 USD Margin: 0.00 Free margin: 996400 Margin level : 0.00% 535.17mt

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606 26
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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1.8  Tools -> Options
1.8.1 Common

At “Common” tab you can change colours of Symbols table.

— Options X

Common | Charts | News

Price up color: I -
pricedown color: | | -

ok || Cancel

Symbol Bid Ask High Llow  Time
EURGEP 0.89215 080222 0,80240 0.89145 12:54:04 ~
AUDCAD 097125 097145 097267 097124 12:54:04
AUDUSD 073919 073927 0.,74023 | 0.73919 12:54:04
NZDIPY 75612 75622 75709 75607 12:54:04
AUDIPY 82228 82238 82315 82226 12:54:04
LTCETC 0.01090 001090/ 0.01091| 001088 12:53:52
BTCUSD 7697.70 7697.90 7698.00 766410 12:53:53
LTcusp 83.913 83945 83946 083.543 12:52:52
BCHETC 0.10597 0.10599 0.10599 0.10585 12:53:52
ETHETC 0.06005 006005 0.06016 | 0.05994 12:53:37
ETHUSD 461.580 461.730 | 462.010 460.230 12:52:53
ZECUSD 191.680 192,100 192,280 188.000 12:53:52
ZECBTC 002488 002488 002488 002448 12:53:52
BCHUSD 816.740 816,760 816760 811.440 12:53:52
CADIRY 84,652 84664 84703 84583 12:54:04

I INENTSY) INSEAE NP NNTTE (ERIN
LIS Dy DN, 111 220 141244 141 23683 141 140 12,5404 -

Binary Options

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606 27
Phone: +1.312.772.2081] Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com



el

TradeToolsFx
1.8.2 Charts

“Tools” ->“Options” -> “Charts” -> “Show trade lines” checkbox enables position opening price line on chart.

= Options x
Common | Charts | News

[] Show trade lines

EURUSD, M1 EURUSDbe, M13 CHFJPY, M13 X

1

Jul 19, 07:45

11207
111.979
111.886
111.793

11:15 14:45 18:15 2145 Jul 20 04:45 08:15 11:45 1515 18:45 01:15 04:45 08:15

11:15 14:45 2145 Jul20 0445 08:15 11:45 15: 1845 0115 0445

TradeTools Technology, Inc.
100 S. Wacker Drive, Suite 225, Chicago, IL 60606
Phone: +1.312.772.2081| Email: info@TradeToolsFX.com| Web: www.TradeToolsFX.com
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1.8.3 News

You can add any “RSS” source of market news directly to FXNEXT terminal “news”

tab

£ Options X

Common | Charts | News

Bitcoin News
https.//news.bitcoin.com/feed/

| ok || Cancel

-

Time Content

The Daily: TCAP Explores Ma Tutanota Acc Cryptos, Huobi Launches Cloud )
In todaysh™s edition of Bitcoin in Brief we cover stories about one of the largest inter-dealer brokers in the world exploring the

2018.07.23 12:52 cryptocurrency market, a privacy-focused email service that now accepts several cryptos, a new white label exchange offering and a
cloud mining service that abruptly ended BTC cantracts. Also Read: Coinbase Gets 520 Billion [8:#8230:The post The Daily: TCAP
Explores Market, Tutanota Accepts Cryptos, Huobi Launches Cloud appeared first on Bitcoin Mews,

PR: Vaultbank to Bring Free Stock Trading with Margin, Top 20 Cryptos, 120+ Fiat Currencies
SAN FRANCISCO -- Vaultbank announces the additicn of free stock trading to its October Launch. This is in addition to crypto
trading and issuance of security tokens. With all of these services on one platform, users will have a single platform solution to
2018.07.23 12:30 invest globally, trade digitally, and cash out locally.The Vaultbank Platform is currently in beta testing. A tiered global rollout is
scheduled to begin in Qctober 2018, Prospective users are invited to join the waitlist on Vaultbanks®™s homepage at
vaultbank.io.The post PR: Vaultbank to Bring Free Stock Trading with Margin, Top 20 Cryptos, 120+ Fiat Currencies appeared first o
Ditcoan bl
T

Trade | BO Positions | Trade History | Mews |

1.9 Help
Help form displaying FXNEXT trade terminal version information

2o About >
I FXGO Trade Terminal
Version 1.0.6729
© 2018 TradeToolsFX

«.'

Notice: This computer program is protected by copyright laws and international treaties.
Unauthorized reproduction or distribution of this program or any portion of it, may
result in severe civil and criminal penalties and will be prosecuted to the maximum

extent possible under the law.
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